
 
 

 

SAKAI  QUICKSTART GUIDES 
 
These are the quickstart guides for the more popular tools used in Sakai at the Claremont Colleges.  
 
 

MY WORKSPACE QUICKSTART GUIDE 
 
Overview 

My Workspace is an individual online worksite that functions as a private workspace for each user. 
When you log in, you will automatically open My Workspace, which will display the Message of the Day 
and My Workspace Information boxes. By default, these boxes contain announcements and information 
from the system administrator. 

Only a system administrator can modify the contents of the Message of the Day box, but you can 
customize how announcements will display in the window. To do so, click Options under "Message of 
the Day". 

Features: 
In My Workspace, you can perform various tasks, including: 

 Posting files in your own private Resources tool  
 Viewing an integrated Schedule for all sites in which you participate  
 Viewing Announcements from all your sites  
 Creating your own private Schedule items  
 Viewing a list of all sites you belong to in Worksite Setup  
 Revising worksites you own by adding users or changing tools  
 Choosing how you would like to be notified of new or changed items on sites you belong to in 

the Preferences tool  
 Adding yourself to publicly joinable sites with the Membership tool  

 

Things to consider 

 In My Workspace, you can print a PDF file of all your Schedule events for the day, week, or 
month.  

 You can save drafts or backup copies of work in progress in My Workspace Resources.  
 For help documentation about My Workspace, click the blue Help Button on the page.  

 
For specific instructions on the tools within My Workspace, see: 
 

 Changing notification preferences 
 Setting Message of the Day options 
 Showing, hiding, and ordering sites 
 Adjusting the time zone 
 Changing your privacy status 
 Editing My Workspace Information 
 Adding, removing, hiding, or reordering tools 
 Adding the Wiki tool to your site 
 Publishing or unpublishing a site 
 Controlling access to your site 
 Editing information about your site 
 Adding, editing, or removing participants 
 Changing participant roles 
 Adding a text description to your site  



 
 

 

 
Changing notification preferences 
 
From My Workspace, you can set your email and notification preferences. 

Note: With the exceptions of the Wizards and Matrices tools, you cannot adjust your preferences for 
individual sites. For example, if you set your email notification to deliver a daily summary, you will get 
a daily summary message from all sites to which you belong. Or, if you choose to block low priority 
announcements or low priority resource notifications, these will be blocked for all your sites. You 
cannot block receipt of high priority notifications. 

To change your email and notification preferences: 

1. On your My Workspace menubar, click Preferences, and then click Notifications.  

2. For each tool, choose whether you would like to receive low priority notifications separately, 
once a day in an email summary, or never.  

Note: For the Wizards and Matrices tools, to override this preference for a specific site, click 
Add a Site. 

3. When you are finished, click Update Preferences to save your preferences.  

 

Showing, hiding, and ordering sites 
 
Note: When you log in, your course and project sites are displayed as tabs across the top of the 
screen. To enter a site, click its tab. If you belong to more sites than can be displayed as tabs, those 
sites will be accessible from the  - more -  drop-down list. 

You can choose to hide sites (e.g., course sites from previous semesters), or reorder them (i.e., choose 
which sites to display in tabs), using the Preferences tool in My Workspace. 

1. From your My Workspace menubar, click Preferences.  

2. Click Customize Tabs.  

3. Under "Customize Tabs", you can use the right and left arrow buttons ( <  and  > ) to move 
sites from the "Sites visible in Tabs" box to the "Sites not visible in Tabs" box and vice versa. 
Click the double arrow buttons ( <<  and  >> ) to move all sites from one box to the other.  

Note: Sites in "Sites not visible in Tabs" are also hidden from the - more - drop-down list. 
However, you can still access them from Worksite Setup in My Workspace. 

4. To determine the order in which tabs are displayed, click a site in the "Sites visible in Tabs" 
box, and then use the up and down arrows to change the order.  

Note: Your My Workspace tab will always appear to the left of your other sites. 

5. You can change the number of tabs you see with the drop-down list next to "Tabs displayed".  

6. When you're finished, click Update Preferences.  

 

 
CHAT ROOM QUICKSTART GUIDE 
 
Overview  
 
The Chat Room tool can be used for real-time, unstructured conversations among site participants who are 
signed on to the site at the same time.  
 
Things to consider  

 Chat messages are saved and visible to all users so that all site participants can benefit from 
clarifying conversations and questions and answers. By default, all Chat messages are shown for at 
least three days; this can be extended.  

 The Chat Room tool does not provide a way to chat privately. By default, all messages are visible to 
all participants.  



 
 

 

 Chat Room tool allows the creation of multiple chat rooms but only one room can be active at any 
given time.  

 
Reading Chat Room messages  
 
To read messages in the Chat Room, do the following:  

 In the menu bar, click Chat Room.  
 To see who is presently in the Chat Room, look under "Users in Chat" on the right side of the screen.  
 Messages appear in chronological order, with the most recent at the bottom. Messages will always 

identify the sender.  
 To hide or display the date or time messages were posted, select the appropriate option from the 

"View" drop-down list: Time Only, Date and Time, Date Only, or Neither Date or Time.  
 To limit the list to messages from only the past three days, click Past 3 Days. To return to a view 

listing all messages, click All Messages.  
 
Posting Chat Room messages  
 
To post a message, follow these steps:  

1. In the text box at the bottom of the window, type your message, and then click Add message.  
Note: No one will be able to see your message until you click Add message, but once you 
do, only an instructor or a participant who has special permission can delete your message.  

2. To discard a message that you haven't yet sent, click Clear.  
 
eleting Chat Room messages  
 
You can only delete a Chat Room message if the instructor has granted this permission. To delete a 
message, simply click the trash can icon next to your name of the posting, and then click Delete. If you 
don't see a trash can icon, you don't have permission to delete the message.  
 
Accessing different Chat Rooms  
 
Instructors can set up multiple Chat rooms for a site. To access different chat rooms, click Change Room 
button above the open Chat room, then click a desired room from the list to access.  
 
 
 

EMAIL ARCHIVE QUICKSTART GUIDE 
 
 

Overview 
 
Each site has an automatically generated site email address, which you can view in the Email Archive 
feature. Email sent to the site email address is copied to all site participants. The site owner can create an 
easy-to-remember alias for the site's email address. All messages sent to this address are stored in the Email 
Archive. 
 
Adding the Email Archive to your site 
 
To add the Email Archive tool to your site: 

1. In your site's menu bar, click Site Info 
2. Near the top, click the Edit Tools link 
3. Under Choose tools to include on your site, check the box next to "Email Archive", and then scroll 

down and click Continue. 
4. Under "Email Archive", in the field next to "Site email address", enter a name for the site email 

address (e.g., SCHIST101A) with NO spaces. This will be the name (alias) that goes before the “@” 
in your course email address, e.g. SCHIST101A@sakai.claremont.edu. 

5. Click Continue, and on the subsequent confirmation screen, click Finish to return to the Site Info 
screen.  

You should now be able to see and click Email Archive in your site's menu bar. 
 
Change Default Settings 
 

1. In the menu bar of your course or project site, click Email Archive. If you don't see Email Archive, 
it has not been added as a tool for this site—see “Adding the Email Archive to your Site” above 



 
 

 

2. Permissions:  to control permissions for an Email Archive: 
a. In the menu bar of the course site or project site, click Email Archive 
b. Click Permissions 
c. Place checkmarks in the appropriate boxes to control which roles will be able to create, read, 

revise, and delete messages in the Email Archive 
d. When you have made your changes, click Save.  

3. View Options:  to customize the way you view an Email Archive: 
a. Use the Viewing drop-down list above-right of the list of messages to change the number of 

messages displayed on each page 
b. Click the heading of any column of the message list to sort by that column. Click the heading 

again to change the display order from ascending to descending, or from descending to 
ascending.  

4. Set the Email Address:  change the alias email address for the site: 
a. Click Options  
b. Under Mail Address, type a new name WITHOUT any spaces 
c. Click the Update Options button 

5. Access Options:  to customize how messages are sent to an Email Archive: 
a. Click Options 
b. On the Customize screen under Mailbox settings: 

 click the corresponding radio button to have messages accepted from anyone, or only site 
participants 

 click the corresponding radio button to set the Reply To address to the Email Archive, or to 
the Original Sender 

c. Once you have made your desired changes, click Update Options.  
 
Sending mail to course or project site participants 
 
To send an email to your course or project site: 

1. From your email program, send an email to the email alias that you created  Messages will go to all 
participants in your course or project site—to their individual email account—and will be stored in 
the Email Archive. 

Note: You cannot use Email Archive to send messages to particular individuals. Messages 
sent to your site's email address are received by all site participants. 

 
Reading messages in the Email Archive 
 
To read messages in the Email Archive: 

1. To navigate through multiple pages of messages, use the arrows above the Date Received column 
header. Click > to go to the next page, and < to go to the previous page. Click |< to go to the first 
page of messages, and >| to go to the last pages of messages.  

2. You may also search the archive using the Search box and button (see below). 
3. When you locate the message you want to read, click its highlighted subject line to read it. The 

Next Email and Previous Email buttons allow you to move from message to message. Click View 
Headers to see the full headers, and Hide Headers to hide them.  

4. While viewing a message, you may remove it from the archive (if you have sufficient permissions) 
by clicking Delete. On the following confirmation screen, click Remove to complete the deletion, 
or click Cancel to return to the message without deleting it.  

 
Searching an Email Archive 
 
To search for a word in the email messages within an archive, follow these steps: 

1. In the Search box near the top of the screen, type the desired word > then click Search.  
Note: The Email Archive search is not case sensitive. Also, you can search only for a single 
word. Do not use quotation marks around your search term unless you are searching for a term 
in quotation marks. 

2. A list of search results will appear. You may click the linked subject line to view a message. Once 
you are viewing a message, click Return to List to return to your search results. Click View 
Headers while viewing a message to see the full headers; click Hide Headers to hide them (the 
button toggles between these two options).  

3. On the search results screen, click Clear Search or the reset button to return to the default Email 
Archive display (the list of all email messages in the archive). Or you may search the archive again.  

 
Deleting an Email Archive message 
 



 
 

 

To delete an Email Archive message, follow these steps: 
1. In the menu bar of the relevant course site or project site, click Email Archive.  
2. Click the linked subject of the message you want to delete to open it > then click the Delete link 
3. Click Remove to confirm the deletion.  

 
Message formatting and attachments in the Email Archive 
 
 The Email Archive uses plain text to format messages, even if their original format was HTML or rich 

text. If a message is sent in a format other than plain text, site participants can view it in its original 
format by clicking the link provided in the Email Archive message. 

 The Email Archive also uses links to handle attachments. Instead of receiving an attachment directly in 
the body of an email message, site participants can click a link to view the attachment. This feature 
helps prevent site participants from going over quota. 

 
 
 

FORUMS TOOL QUICKSTART GUIDE 
 

Overview 
 
Forums is a communication tool that instructors can use to create discussions for their course or project 
sites. An instructor can modify permission levels for participant roles; permissions must be changed for 
students to be able to create Forums. Forums can be graded and added to the Gradebook.  
 
Creating a forum 
 
A forum is a subject - topics must be created within forums for posting.  When creating a forum, at least 
one topic must be added so the forum is visible and site participants can post messages. To create a new 
forum: 

1. Click New Forum; the Forum Settings screen will open. 
NOTE: A Forum is a subject; comments and discussions should be posted as Topics. 

2. In the Forum Title field, type your forum's title 
3. In the Short Description field, you can type a brief description 
4. In the Description WYSIWYG text editor, you may enter a more detailed description of your forum, 

instructions, etc. – do NOT enter a discussion as this is done within topics.  
 
 
 

5. Click Add Attachment to attach a file from your computer or Resources, or add a URL 
6. To moderate forum postings, under Forum Posting, click the Yes radio button next to Moderate 

Forum 
o Under Permissions, you can modify permission by roles: select a role > then either select a 

predefined Permission Level from the list, or check permission boxes as needed.  
7. Next to Gradebook Assignment, use the list to choose an assignment already in the Gradebook 
8. When finished, click one of the following: 

o Save Draft: Save your forum as a draft. Drafts are not available to other site participants 
o Save Settings & Add Topic: Save your changes and add a Topic to your Forum. You will 

need to add a Topic to a Forum so site members can post messages.  
o Cancel: Cancel your changes; you will return to the Forums screen.  

 
Creating a topic 

1. Go to the Forums screen and find your forum's title. To its right, click New Topic. 
1. Next to Topic Title, enter a title in the text box. 
2. Next to Short Description, you may type a brief description 
3. In the Description text editor, enter a more detailed description of your topic, or post a discussion  

NOTE:  Use the Paste From Word tool if you copy and paste text from a Word document 
4. Click Add Attachment to attach a file from your computer or Resources, or add a URL 
5. To moderate topic postings, under Topic Posting, click the Yes radio button next to Moderate 

Topic 
8. When you're finished, Save your changes, or Cancel to discard.  

 
Changing the order of forums and topics 

1. Click Organize. 
2. Use the drop-down lists to manipulate the order of forums and topics. 

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 



 
 

 

3. When you're finished, click Save Settings. To cancel, click Cancel.  
 
Revising a forum or topic 
 
Note: You cannot delete an individual forum message. You can, however, revise the message and remove its 
contents. Also, you can delete the forum or topic entirely, which will remove any associated messages. 
 
To revise a forum, a topic, or the default template for newly created forums and topics: 

1. Under Forums, click to choose one of the following: 
o Template Settings opens the default Template Settings screen where you can change 

default Permissions and Moderate Topics settings. 
o Forum Settings opens the Forum editing window where title, description, and default 

settings can be changed, attachments added or deleted, and the forum deleted. 
o Topic Settings opens the Topic editing window where title, description, and default topic 

settings can be changed, attachments added or deleted, and the topic deleted.  
2. When you're finished, click one of the following: 

o Save Settings saves your changes and returns you to the Forums screen.  
o Safe Draft saves your forum as a draft and returns you to the Forums screen.  
o Save Settings & Add Topic saves your changes and opens the Topic Settings screen 
o Delete removes your Forum and/or Topic with all associated messages  
o Cancel will cancel your changes and return you to the Forums screen.  

 
Deleting a forum or topic 

1. On the Forums screen, find the forum or topic you wish to delete, and next to its title click one of 
the following options: 

o Forum Settings opens the Forum Settings screen.  
o Topic Settings opens the Topic Settings screen.  

2. At the bottom of the screen, click Delete. 
3. You'll see a warning message to confirm deletion. To delete the item, click Delete. To cancel, click 

No.  
 
Viewing Forums and Topics 

 Each forum appears in an enclosed box with its title and short description displayed below the title. 
If a full description of the forum exists, click Read Full Description to view it. 

 Beneath the forum title, topics are listed by title, and include a short description 
 Clicking the title of any forum will open an isolated view of a particular forum and its topics. 
 Clicking the title of any topic will display a thread of messages for that particular topic. Each 

individual thread appears in an enclosed box with a count of messages below. Use the arrows to the 
left of the messages to expand the threads 

 To expand all threads and messages, click Display Entire Message. To mark all of the messages as 
read, click Mark All As Read.  

 To open a printable version of all Topic messages, click the printer icon at the top. 
 Clicking the title of the topic thread will open an isolated view of a particular thread and its 

individual messages. Use the View drop-down list to change the display of messages. 
 To open an individual message, click its subject link. 

 
Posting a new message 

1. From the Forums tool, click the title of the topic for which you'd like to post a message 
2. Click Post New Thread;  the Compose Forum Message screen will open 
3. Next to Title, type the subject (i.e., title) of your message 
4. Under Message, use the WYSIWYG editor to compose your message 

NOTE:  Use the Paste From Word tool if you copy and paste text from a Word document 
5. Under Attachments, you can attach a file from your local computer or from Resources, or specify 

the URL for a file on the web 
6. When you're finished, click Post Message or click Cancel.  

 

Note: If the forum or topic is moderated, the message will appear as "PENDING" until approved by a 
moderator. 
 
Posting a response to a message or topic 

1. Click the Title of the desired topic 
2. Click the subject of the desired message 
3. Click Reply to Thread or Reply 
4. In the text field next to Reply Title, give your reply a title 



 
 

 

5. Under Message, use the WYSIWYG editor to compose your reply. To insert a quote of the original 
message, click Insert Original Message (located above the WYSIWYG editor). 

NOTE:  Use the Paste From Word tool if you copy and paste text from a Word document 
6. Click Add Attachment to attach a file from your computer or Resources, or add a URL 
7. When you're finished: 

o To post your message, click Post Message 
o To cancel your message without saving it, click Cancel.  

 

Note: If the forum or topic is moderated, the message will appear as "PENDING" until approved by a 
moderator. 
 
 
 

MESSAGES QUICKSTART GUIDE  
 
 

Overview 
 
The Messages tool is a communication tool that allows site participants to communicate using internal 
course email. Private messaging between groups is also supported.  A WYSIWYG interface allows rich text, 
plain text, and HTML editing. You can also add attachments. 
 
The Messages tool is intended for private correspondence with other individuals or groups in your site. 
Messages are organized into default Received, Sent, and Deleted folders. New folders can be created.  
 
 
Sending and replying to messages 
 
Using Messages, you can send email to other site participants, and reply to messages sent by other 
participants. 
 
Sending a message  
 
To compose and send a message, follow these steps: 

1. In your site's menu bar, click Messages. 
2. On the Messages screen, click Compose Message, or, while viewing the contents of a Messages 

folder, click Compose Message. 
3. Next to "To", use the list to select the individual(s) or group(s) whom you want to receive the 

message. To select multiple participants, use Ctrl+click (in Windows) or Cmd+click (in Mac OS X). 
You can also choose to send your message to the entire site, or to all users with a particular role 
(e.g., all instructors or all assistants). 

4. Next to "Send CC", check the box for ‘Send a copy of this message to recipients email addresses’ to 
send email to site participants selected.  

5. Under "Label", use the drop-down list to change the priority status for your message. 
6. Next to "Subject", type the subject (i.e., title) of your message. 
7. Under "Message", use the WYSIWYG editor to compose your message. 

 
 

 
 

8. Under "Attachments", you can attach a file from your computer or from Resources, or specify the 
URL for a file on the web.  

9. When you're finished, click Send to send your message. Or, click Cancel to cancel your message.  
 
 
Replying to a message 
 
To reply to a message someone sent to you, follow these steps: 

1. In your site's menu bar, click Messages. 
2. On the Messages screen, click Received to view the messages you've received.  
3. Click the message to which you are replying. 
4. Click Reply. 
5. To compose and send your reply, follow steps 3 through 9 above.  

 
 

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 



 
 

 

Viewing and managing messages 
 
The following functions are also available in the Messages tool: 

 To create a new personal folder, click New Folder > give it a Title > click Add 
 To forward your messages to an email address of your choosing, click Settings. Next to "Auto 

Forward Messages", click Yes. Type the desired email address in the text box provided > then click 
Save Settings. 

 The total number of messages and unread messages for each folder is displayed next to the folder's 
title. To see the contents of any folder, click the folder's name.  

 
Inside a folder, you will see a list of messages arranged by date. 

 To sort messages, click the relevant column title for Subject, Authored By, Date, or Label. 
 To change the way messages are displayed, from the "View" drop-down list, select either All 

Messages or By Conversation. 
 To view another folder, click Previous Folder or Next Folder. 
 To compose a new message, click Compose Message (see above) 
 To view the contents of a message, click its subject.  
 

Inside a message, you will see the message contents and other details. 
 To view another message, click Previous Message or Next Message. 
 To compose a reply, click Reply.  

 
 
 

 To move a message to another folder, click Move to folder. Use the radio buttons to select a 
destination folder, and then click Move Message. 

 To delete a message, click Delete. To confirm the deletion, again click Delete. 
 
 

Searching Messages 
 
To search for text in a message, follow these steps: 

1. In your site's menu bar, click Messages. 
2. Click the folder you wish to search. 
3. Next to "Search for text:", enter your search terms in the text box, and then click Search. 
4. To modify the search parameters, click Advanced Search. Available parameters are: 

o Subject: The subject line of the message 
o Authored By: Who sent the message 
o Body: The body of the message 
o Label: The label associated with the message 
o Date Range: Enter the beginning and ending dates in which the message was sent 

5. To clear a search, click Clear Search.  
6. To end an advanced search, click Normal Search.  

 
 
 

 
 
NEWS (RSS) TOOL QUICKSTART GUIDE 
  
Overview  
  
The News tool uses RSS news feeds to bring dynamic news to your worksite. RSS is a data format that is used 
to syndicate news on the web. An RSS news feed is a specially formatted list of news articles.  It allows 
continuously updated content from a remote news site to appear in another website.   
  
  

Adding, editing, or deleting an RSS news feed  
  
You can set up a worksite to display news by entering a URL for an RSS news feed. You can add more than 
one News tool at any time.   
  

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 



 
 

 

Adding a news feed  
  
To add a news feed, follow these steps:  

1. In the menu bar of your course or project site, click Site Info, and then click Edit Tools.  
2. Check the box for News, and then click the Continue button.  
3. In the "Title" field, enter a title for the news feed that will appear in the menu bar.   
4. In the "URL" field, enter the URL for the news feed.   
5. If the worksite already contains news feeds or web content, you will see information in the Title 

and URL fields:  
a. Click the More News Tools drop-down menu,  
b. Select the number of News tools to be added,  
c. Complete the Title and URL for each.  

6. Click Continue. You will see a summary of your changes to the site's tools.   
7. Click Finish.   

 
You should now see a link in the Menu Bar to the news feed(s) displaying the title you provided.  
  
Editing a news feed  
  
To edit a news feed, in the menu bar, click the title of the feed you wish to edit. Click Options, and then 
change the "Title" and "URL" fields as needed.  
  
Deleting a news feed  
  
To delete a news feed:  

1. In the menu bar, click Site Info, then Edit Tools.   
2. From the list of tools, uncheck the news feed you wish to delete, and then click Continue.   
3. On the "Customize Tools" screen, review your information, and then click Continue.   
4. Click Finish to delete your feed.  

 
Viewing a news feed  
  
If your course or project site has a link to a news feed, you will find it in the site's Menu bar. To view news, 
simply click the title of the news feed from the Menu bar and current news will display.  
 
 
 

POLLS TOOL QUICKSTART GUIDE 
 
Overview 
 
The Poll tool allows users to set up an online vote and obtain results:   

 Vote:  Users can vote for one or more of any number of answer options. The structure of the vote is 
governed by a maximum and minimum number of options that may be selected.  

 Results:  You can choose when results are available to voters: immediately, after voting, after the 
closing date, or never.  

 
Things to Consider: 

 Voting is anonymous.  
 Participants may only vote once per poll.  
 A poll can only consist of one question. If you want to ask a set of related questions it might be 

better to use the Tests and Quizzes tool.  
 You can allow spoilt votes by selecting zero as the minimum number of answer options.  

 
Setting permissions 
To control who may or may not vote, as well as who may create, edit and delete polls, click on Permissions 
in the options bar. Once you have adjusted the permissions by ticking the relevant boxes, click Save. 
 
Creating a Poll 

1. To create a poll, click on Add.  
2. Enter the Poll Question and any additional instructions such as the number of answers that the 

voter may select.  



 
 

 

3.  
4.  

 
 

5. Choose an opening date and a closing date, between which participants will be able to cast their 
votes.  

6. Next, select the maximum and minimum number of answer options that a user may select. If you 
want users to only select one option from the possible answers given, set both numbers to 1. If 
users may select more than one option, adjust these settings accordingly.  

7. Decide how and when results will be visible:  
o Always allows participants to see the results from the open date, even if they haven’t 

voted. 
o Never restricts participants from seeing the results 
o To participants who have voted allows participants to see the results from the open date, 

but only after they have voted 
o After closing date restricts access to the results until the closing date, after which all 

participants (regardless of whether they have voted or not) will be able to view them. 
8. Click on Save and add options  
9. Type in the first answer option available for the question and then click on Save and add options. 

Repeat until all answer options have been entered, then click on Save.  
 
Editing a poll 
To edit a poll, click Edit. Adjust the settings in the form. Links will be provided to add, edit and delete 
answer options. Click Save to finish. 
 
Deleting a poll 
To delete a poll, tick the relevant box in the Remove column and then click Update. 
 
Viewing Poll results 
To view results click the Results link alongside the relevant poll. The number of votes for each answer 
option, the percentages associated with these figures, and the total number of votes will be displayed.  

 
 

PROJECT SITE QUICKSTART GUIDE  
 
Overview  
 
A course site is the official work site for a particular academic course for an institution, and will be 
automatically created prior to the start of each semester by the Sakai Administrator. Instructors do not have 
the ability to create new course sites.  
 
Project sites are designed to facilitate collaboration; they are identical to course sites with all of the same 
tools and functions available. You can create your own project site and add anyone you wish to join the 
site. A project site is a great tool for managing information for groups.  
 
Creating a new project site  
 
To create a work site, follow these steps:  

1. In your My Workspace menu bar, click Worksite Setup.  
2. At the top of the Worksite Setup page, click New.  
3. Under "Creating a new site", click the radio button next to Project Website, then click 

Continue.  
4. On the "Project Information" page:  

a. In the Site Title field, type a title for your project; this will appear on the Navigation Bar  
b. In the Description box, type a description which will appear on your site's home page  

 
 
 
 

c. Type a Short Description for this to appear on the public list of all sites on the system  
d. If you'd like to insert an icon image above the Menu Bar, type in the URL in the "Icon URL" 

field. This image should be no larger than 150 pixels on the long edge.  
e. In the Site Contact Name field, enter your name  

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 



 
 

 

f. In the Site Contact Email field, enter your email address  
g. Click Continue.  

5. Under "Tools", click a box to place a checkmark next to the tools you want to provide on your site, 
and click Continue.  

a. If you select Email Archive, on the “Customize Tools” page which you will see later, you 
will be asked to provide an alias (username) for your site's email address on the next page. 
Recommended: use the Project name with no spaces; do not use your Sakai username.  

b. If you select News, on the “Customize Tools” page you will be asked to provide a title and 
source URL for your news feed. To add more feeds, use the "More News Tools" drop-down 
list  

c. If you select Web Content, you will be asked to provide a title and source URL. To add 
more links, use the "More Web Content Tools" drop-down list, and then click Continue.  

6. You have the option of re-using material from other sites you own. Choose one of the following and 
then click Continue:  

a. No, thanks  
b. Yes, from these sites: Select the sites with the material you want to re-use; on the 

next page, check the boxes for the tools you want to copy, and then click Continue.  
Note: Imported materials will be posted as DRAFT copies. To make them viewable to 
others, open each item and click the Post or Add button at the bottom of the 
page. 

7. On the "Set Site Access" page, under “Site Status,” select Publish site to make it available to site 
participants. If you don't want to publish your site at this time, you can do it later through Site Info.  

8. To indicate who can access your site, on the "Set Site Access" page under Global Access, select one:  
 Private: Only the people you add as participants can see your site.  
 Display my site in the directory, and share files I select: Anyone with authorization to log 

into the system can see your site in the site directory, and can access shared files.  
9. Also, on the "Set Site Access" page you can set your page to be joined by anyone with authorization 

to log into the system; to do so:  
a. Click to place a checkmark in the box next to “Can be joined by any Claremont 

consortium student, faculty or staff member…”  
b. Use the drop-down list to select a role to assign people who join your site.  
c. Click Continue.  

10. On the "Confirm Your Site Setup" page, review the information about your site. If you need to make 
changes, click Back; to cancel, click Cancel; if it is correct, click Create Site.  

 
Your new site will be listed in My Workspace on the Worksite Setup page.  
 
Adding participants to a project site  
 
To add participants and assign them participant roles, follow these steps:  

1. Click Site Info in the Menu Bar; click Add Participants.  
2. Under "Username(s),” type each participant's username, including their school’s three-letter code 

(e.g., jdoe@cmc), on a separate line. The codes are: cgu, cmc, hmc, jsd, kgi, lib, pom, ptz, scr.  
3. For guest participants, enter the full email addresses, one per line.  
4. Under Participant Roles, select “Assign all participants the same role” or “Assign each participant a 

roll individually, then click Continue.  
5. On the next page, select role(s) for your participant(s); click Continue.  
6. On the next page, if you would like to send email to the new participants notifying them of the new 

site, click the radio button for “Send Now,” otherwise click “Don’t Send.” Click Continue.  
7. On the next page, click Finish and the participants will be added. 

 
Editing a project site  
 
To edit a project site that you created:  

1. While in the site you wish to edit, click Site Info in the Menu Bar  
2. At the top of the page, click Edit Site Information to edit the site title, description, short 

description, icon URL, site contact name, or site contact email address.  
3. To add or remove tools from your site, click Edit Tools.  
4. Click Manage Access to change the publishing status of your site, modify who can see or join 

your site, and change the default role for people who join.  
5. To create a duplicate of another of your sites that includes material posted by the instructor, click 

Duplicate Site. This will copy only from the tools you have selected for the new project.  



 
 

 

6. To add material from another site you own, click Import from Site. The tools available for 
importing are:  

 Announcements  
 Assignments  
 Discussion  
 Resources  

 Schedule  
 Syllabus  
 Wiki  

 
Some items (e.g. Announcements, Assignments, Discussions) will be imported as DRAFT copies. To 
make them viewable to others, open each item and click the Post or Add action button at the 
bottom of the page.  

Note: You can re-use material only from other sites that you own. You can combine 
material from more than one site.  

7. To import materials from a zipped file, click Import from File, browse for the file, and then 
click Import.  

 
Deleting a site  
 
To delete a work site that you created, follow these steps:  

1. In your My Workspace menu bar, click Worksite Setup.  
2. Click the box to place a checkmark next to the site you want to delete. Then, at the top of the 

Worksite Setup page, click Delete.  
Note: Deleting a site removes the entire site's content and cannot be undone. No one else 
will be able to access the deleted site or its contents.  

3. On the confirmation page, click Remove.  
 

 

RESOURCES QUICKSTART GUIDE 
 
Overview 

 
In the Resources tool, you can make many kinds of materials available online, including word 
processing documents, spreadsheets, slide presentations, images, links to websites, and simple text 
documents that display right on the page. You can also post items outside of folders, create folders 
inside other folders, upload images for Presentations, and create HTML documents. 

 
Creating/adding an item in Resources 
 
Open the Resources tool on your site’ Menu Bar.  To view all items in your Resources tool at once, 
click the double arrow on the left side of the Title Bar to Expand All; click again to collapse.  

 

Adding a new folder: 
 

By default, your Resources tool contains one folder named after your site. To add a subfolder: 
1. Next to the existing folder, under "Actions", click Add > click Create Folders 
2. Type in the name of your new folder 
3. If you wish to add more folders, click ‘Add Another Folder’ 
4. Click the Add Folders Now button 
5. To Change the name or add a description, click Actions next to folder name > click Edit Details. 

 
Adding resource items: 

 
Click the Add link in the "Actions" column, which is to the right of the folder in which you want to create 
the new item. In the page that opens, from the "Add Item Type" drop-down list, select your resource 
type: 

 
• Upload Files: An existing document or other file from your computer: 

1. Click Add > Upload Files 
2. For each resource, click the Browse button > select a file to upload > enter Display Name 
3. To Edit the resource description, click ‘Add Details for this Item’ 
4. Under "Availablitiy and Access", select the access rights you prefer. The default should be 

that only site members can view these files.  
5. Next to "Email Notification", specify whether or not you want to have members of the 

site notified via email when the resource is posted – select ‘High’ to send email. 



 
 

 

6. Click ‘Upload Files Now’ to finish. 
 

• Add Web Link (URL): Specify a URL to a website that will be the resource: 
1. For each resource, type the URL in the box.  
2. Add a title for the linked web page. If you don't add a title, the URL will be used as the title 

of the resource. To add a description, click ‘Add Detals for this Item’  
3. Under "Availablitiy and Access", select the access rights you prefer. The default should be 

that only site members can view these files.  
4. Next to "Email Notification", specify whether or not you want to have members of the 

site notified via email when the resource is posted – select ‘High’ to send email. 
5. Click 'Add Web Link Now’ to finish. 

 
• Create HTML Page: Create an HTML document: 

1. Enter the content of your page, a title, and an optional description in the text editor > 
Continue 

 
 
 

 
2. Choose your page's copyright status, add optional copyright information, and choose whether 

you want to display a copyright alert. 
3. Under "Availablitiy and Access", select the access rights you prefer. The default should be 

that only site members can view these files. 
4. Next to "Email Notification", choose whether or not you want to have members of the site 

notified automatically via email when the resource is posted - select ‘High’ to send email.  
5. Click Finish. 

 
• Create Text Document: Create a plain text document: 

1. 1.   Type the content text > Click Continue   a title, and description in the appropriate text 
areas 

2. Select the copyright status, enter optional copyright information, and choose whether you 
want to display a copyright alert 

3. Under "Availablitiy and Access", select the access rights you prefer. The default should be that 
only site members can view these files. 

4. Next to "Email Notification", choose whether or not you want to have members of the site 
notified automatically via email when the resource is posted - select ‘High’ to send email. 

5. Click Finish. 
 
Upload/Download Multiple Resources with WebDAV: 
 
A WebDAV connection is an easy way to move blocks of files or folders to and from Sakai Resources in 
Windows 7.  Note that there must be at least one object (file, folder etc.) in the Sakai site Resources Tool 
before you begin the setup procedure below. 
 

1. Log on to your Scripps Windows 7 computer with your network login 
2. Open your Sakai site to the Resources tool > click the button for Upload-Download Multiple 

Resources near the top of the window 
3. Follow the instructions for Windows 7: 

a. Highlight the sakai.claremont.edu/dav/  URL provided and copy it to your clipboard 
b. Click the Windows Start button > click computer 
c. At the top of the window, click Map Network Drive 
d. Select a vacant drive letter from the Drive drop down menu 
e. In the Folder field, paste the URL for this site > click Finish 

4. Enter your Sakai username (username@scr) and network password when requested 
5. With My Computer open, you can now move files to and from your newly-mapped NW drive.  You 

can rename the drive by right-clicking > click Rename > type in site name.  
 
Edit a resource item 
 
You can revise plain text and HTML documents; for other document types, the edit option only allows 
you to revise the information about the resource (e.g., the description), or replace the document's 
contents (e.g., picture or URL). You can only replace document content with documents you upload from 
your computer. 

1. If it is a document type for which you can revise the content, click Actions > Edit Details  

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 



 
 

 

2. Make any changes needed.  
3. Click the Update button at the bottom of the page when done. 

 
Move an item in Resources 

1. In the menu bar, click Resources. 
2. Place a checkmark in the box next to the file you wish to move > Click Move 
3. Folder icons will appear to the right of folder names > click the folder icon for the 

destination folder  

 
Copy an item in Resources 

1. In the menu bar, click Resources. 
2. Place a checkmark in the box next to the file you wish to copy > Click Copy  
3. Folder icons will appear to the right of folder names > click the folder icon for the destination 

folder  
 

Reorder Items in Resources 
1. Click Actions > Reorder link to the right of the folder which contains the file(s) to be reordered; You 

may not see a Reorder link if the folder contains less than two items 
2. Drag and Drop the items to their new positions in the list 
3. Click the Save button. 

 
Delete a resource item 

1. Check the box to the left of the Resource name 
2. Click the Remove Link above the list of resources 
3. A confirmation screen will appear > Click Remove to confirm, or click Cancel. 

 
 
SIGN-UP TOOL QUICKSTART GUIDE 
 
Overview  

The Sign-Up tool allows site organizers to create and organize events such as office hours, review sessions, 
study groups, or other activities.  

Create a new event  

An organizer can create three different types of events: a multiple-slot event, a single-slot event, and an 
open meeting. In a multiple-slot event the total time is divided into multiple meeting slots. In a single-slot 
event there is one time slot with a limited or unlimited number of participants. An open meeting does not 
require participants to sign-up.  

1. Important note: Before using the Sign-Up tool please make sure that you have also added the 
Schedule tool to your site. The Schedule tool must be present in order for the Sign-Up tool to work 
properly. The site must also be Published. You cannot add the Sign-Up tool to an Unpublished site.  

2. In your site, from the menu bar, click Sign-Up, then click Add.  
3. Fill out the fields to describe your event:  

a. Title: name of your event  
b. Location: where the event will take place  
c. Description: a description of your event (optional)  

 
 
 

d. Start time: day and time event will begin  
e. End time: day and time event will end  
f. Meeting frequency: how often event will occur (optional)  
g. Sign-up begins: when participants can begin signing up based on the starting time of the event 

(optional)  
h. Sign-up ends: when participants can no longer sign up; they can still cancel (optional)  
i. Available to:  

i. Current site: you can allow all site participants to sign up or restrict it to certain groups  

Note: To copy and paste from Word, you must use the Paste From Word tool on the text editor toolbar:   
 



 
 

 

ii. Other sites: you can also allow participants from other sites to sign up  
j. Meeting type  

i. Choose “Multiple slots” if you want the total time to be divided into multiple meeting slots. 
If you choose this option you will also need to specify the number of slots available for 
sign up, the number of participants per time slot and the duration of each time slot.  

ii. Choose “Single slot” to specify one time slot with a limited or unlimited number of 
participants.  

iii. Choose “Open meeting” to create an event that does not require participants to sign up.  
4. Click Next.  

a. There are three checkboxes that you can specify:  
i. Display Participant Names: display names of participants to others  
ii. Receive Notification: receive email notification when a participant signs up or cancels an 

appointment  
iii. Announce Availability: send email to notify all the potential participants of your event  

b. Other Default Settings: click to expand this list if you want to use these options: 
i. Allow Wait list: Yes, add Wait List option. Participants can join Wait List 
ii. Allow Adding comment: Yes, participant can add a comment during sign-up 
iii. User ID Input Mode: Yes, I want to use User ID input Mode for adding participants 
iv. Auto Reminder: Yes, send email to remind attendee of the meeting, one day in advance 

c. Click the Publish button to save and announce your event. If you know some of the participants 
and want to sign them up yourself you can also choose the Assign Participants & Publish 
button.  

 
Your published event(s) will also appear in the Schedule tool.  
 
 

View your events  
 

1. In your site, from the menu bar, click Sign-Up.  
2. Click the View dropdown menu to change the timeframe for the view.  
3. Click the Title of an event to see details of the event.  
4. Click the box for ‘Expand all recurring meetings’ to view a list of recurring items  
5. You can add participants from the detail view of an event. Click the Add Participant button next to an 

event time slot in order to add a participant. Select a participant from the dropdown list and then click 
OK.  

6. To modify the details of an event click the Modify button in the upper menu.  
7. Once you have made your changes click the Publish Modifications button to save your changes, or the 

Cancel button to cancel them.  
 

Remove an event  

1. In your site, from the menu bar, click Sign-Up to view all events.  
2. Next to the event, check the box under Remove.  
3. Click the Remove meetings button.  
4. Click OK.  

 

Sign up for an event as a participant  

To sign up for an event as a participant, follow these steps:  
1. In your site's menu bar, click Sign-Up.  
2. Click the title of the event you would like to sign up for.  
3. If there are slots available you can click on the Sign Up button to sign up for the event.  
4. If the event is full you can click on the Join Wait List button to join the wait list.  

 

Cancel an event for which you are signed up 

If you are signed up for an event as a participant and want to cancel, follow these steps:  
1. In your site's menu bar, click Sign-Up.  
2. Click the title of the event you would like to cancel.  
3. Click the Cancel Sign-up button next to the time slot that you are signed up for.  

 
 



 
 

 

 
SITE INFO QUICKSTART GUIDE 
 
Overview 

The Site Info tool provides information and allows modification of the worksite that you are currently in. 
You can change available tools, information about the site, and access to the site, and also publish the site 
here.  
 
 

Editing information about your site with the Site Info tool 

1. In your site, from the menu bar, click Site Info, then click Edit Site Information.  
2. In the "Site Title" field, edit the title of your site.  

Note: You can edit the title of a project site you created, but not a course site.  
3. In the "Description" field, type information that you want displayed in your site's Worksite 

Information box. This can also be done in the Home tool by clicking the Options link in the Worksite 
Info window. 

Note: If you have chosen to display a web page in Worksite Information on the Home menu, 
then the text in the description field will not appear.  

4. If your site is publicly joinable, in the "Short description" field, type information that you want 
displayed in the list of joinable sites.  

5. Type the appropriate information in the "Site Contact Name" and "Site Contact Email" fields, and 
then click Continue.  

6. On the confirmation screen, click Finish. To cancel your changes, click Cancel.  
 
 

Adding or deleting tools in your site 
 
Following are the steps for changing the tools in a course or project site: 

1. In your site, from the menu bar, click Site Info, then click Edit Tools. 
2. Check or uncheck boxes to add or remove tools from your site. 
3. Click the Continue button, and on the next page click the Finish button. 

 
 

Controlling access to your course or project site from Site Info  

1. In your site's menu bar, click Site Info > then click Manage Access.  
2. For others to see your site, check the box next to Publish site. 
3. For project sites, under "Global Access" you may choose from the following:  

o To keep your site private, click the radio button next to Private so that only your active 
site participants can view the site.  

o You may select Display in public site list. Your site will then appear in the list of sites on 
the Sakai welcome page under “Sites”. You can then choose to make individual items in 
your site visible to outside users by choosing the Public option when adding content to your 
site. Choosing this radio button does NOT make your entire site visible to the outside 
world, only those items that you choose to make Public.  

o To make your course or project site accessible to any Claremont Colleges user, click the 
checkbox next to ‘Can be joined by any Claremont consortium student, faculty or staff 
member...’  Next to "Role for people that join site", select the “Access” or “Student” role. 
Do NOT choose “maintain” or “Instructor” since then anyone who joins your site would 
have the ability to delete items in your site, and even delete the entire site.  

4. For course sites, the only option under Global Access is ‘Can be joined by any Claremont 
consortium student, faculty, staff...’  You can still make individual items public by checking the 
Public checkbox when adding new items to a site, for example in the Resources tool.  

5. Click Update.  
 
 

Adding, editing, or removing participants with Site Info 
 
Adding participants 

1. In your site’s menu bar, click Site Info. Under the Name heading you will see a list of site 
participants, their roles and status. 

2. Click Add Participants > On the next page: 



o For participants with Claremont Colleges usernames, under "Username(s)", type the
participant's Sakai username, including the school’s three-letter code (e.g., jdoe@cmc). If
you wish to add more than one participant, enter each username on a separate line.

Note: The three-letter codes are: cgu, cmc, hmc, jsd, kgi, lib, pom, ptz, scr 
o For participants without Claremont usernames, under "Guest(s) Email Address", enter the

full email addresses, one per line. 
Note: Sakai will send guest users an email with their temporary password when 
their account is FIRST created. It will not send the password again even if the 
guest is added to another Sakai site. Guests use their email address as their login 
name.

o Under "Participant Roles", choose whether to give all your newly added participants the
same role or different roles. Click the Continue button. 

IMPORTANT NOTE TO INSTRUCTORS:  If you are adding a Claremont student to a course site, you 
must add them using the Auditor Role.  Once they are added to the student database, when the Sakai 
server is updated their role will be changed to Student.  (If you add them as Student, when Sakai 
updates it will see a “conflict” and inactivate their account in the Sakai course site.)  

3. On the next page, choose the roles for the participants you are adding, then click Continue:
o If you selected “Assign all participants to the same role,” click the appropriate radio

button
o If you selected “Assign each participant a role individually,” use the drop-down list next to

each name to select the appropriate role.
4. On the next page, you have the option to automatically send email to the new participants,

notifying them of the site's availability. (This is NOT the same as the email that Sakai sends to
guests with their password.) Select the appropriate radio button, and then click Continue.

5. Confirm that the information for the participant(s) you're adding is correct, and then click Finish.

Editing/Removing participants 
1. In your site’s menu bar, click Site Info.
2. Under the Name heading, you can change a participant's role using the drop-down list under "Role".
3. Under "Status", use the drop-down list to change a participant's status; choose Active or Inactive.
4. To remove a participant, check the box next to the participant’s name in the Remove column.
5. Click Update Participants for the changes to take effect.

Page Order 

You can change the alphabetical order of the tools as they appear in your site’s toolbar and even rename 
them by using the Page Order Tool. 

1. In your site's menu bar, click Site Info > then click Page Order.
2. To reorder the tools simply drag and drop the tools into the order you want.
3. To rename a tool click the Edit icon next to the tool you want to rename.
4. When you’re done be sure to click the Save button.

For additional information, please refer to the online Help 
feature in the Sakai tool. 
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